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Product Installation

Welcome  Film Fix is a new plug-in set designed for Adobe After Effects and 
Windows® XP. Film Fix lets you remove unwanted artifacts from 
digital media transferred from film.

Film Fix comes packaged as a complete software installer. You 
must have installed Adobe After Effects 6.0 or later before install-
ing Film Fix. The installer will automatically place the required 
components on your hard drive.

The installer will guide you through the process of installing the 
plug-in. You will be prompted for a serial number during installa-
tion.

Activation  The final step in the installation before placing the plug-in on your 
system is activating the plug-in. YOU MUST ENTER A SERIAL 
NUMBER TO USE Film Fix. Your serial number is provided in 
email form automatically when you purchase the product as a 
download. You may also find the serial number on the inside of 
the Film Fix package.

The serial number for Film Fix appears in the following format:

  #### #### #### #### ####

All the characters are numbers. You must enter all numbers in the 
serial number entry dialog before the installation can proceed.
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Product  
Support

 Product support is available to registered customers only.

You can register with Red Giant Software by opening your web 
browser and using the following URL:  
 
http://www.redgiantsoftware.com/register.html. 

The best way to reach support is to email your support issue to 
support@redgiantsoftware.com. We offer a 24-hour turnaround 
time on all support email.
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Introduction

You don’t need a PhD to make old films look their best. Film Fix 
is designed to allow you to restore degraded film originals using 
simple controls to repair the most common problems in old film: 
jitter or shake, flicker and dirt, or splotches.

There are a host of reasons to restore an old film. The first is pres-
ervation. While film has a great shelf life, it does degrade over time 
and at some point the image will be unrecoverable. Even if the film 
is in good shape, you may have a master that has degraded because 
of mishandling or improper storage. Third, you may want to use 
this old media in a DVD or video production and you must meet 
certain quality standards

Film Fix is designed to work primarily with material that was 
originally shot on film. This means that it works with digital me-
dia that was acquired by scanning film into a computer through 
a telecine process. Film Fix will work best with images that were 
captured with a high-quality scanning process. The lower the qual-
ity of the capture process, the less pleasing the results will be from 
the Film Fix tools.

 Before you begin using Film Fix you will need to remove pulldown 
from any digital files. Inverse Telecine or 3:2 removal is a method 
for removing duplicate fields when media is transferred from film to 
video tape. Adobe After Effects can remove these duplicate fields by 
specifying the phase or order in the Interpret Footage dialog.

 The tools are designed to work on progressive frames and not on 
video. Please make sure that you only use true frame-based mate-
rial or you may get incorrect results with the Film Fix plug-ins.
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Film Fix Walkthrough

Before you start, you should try to identify the problems with 
your footage, just by viewing the sequence and making an initial 
judgement. For instance, flicker is present if you see brightness 
fluctuations over the whole image from frame to frame, shake is 
easily noticed (e.g. handheld camera shake), and spots of bright or 
dark light or dirt are evidence of splotches. After identifying the 
problems, there is a recommended sequence for applying the cor-
rection tools.

This section will take you through the process of using the tools in 
Film Fix. We recommend that you process the footage as outlined 
in this walkthrough. You should always try to use the Flicker Re-
mover first, then the Stabilizer, then Dirt Remover. The file WWI_
short_18fps.mov is provided on the disc and can be used with the 
steps that follow.

The Tear Remover is an alignment tool that only needs to work on 
a single frame.

 Before you process any footage you need to make sure that the foot-
age is broken up in After Effects into individual scenes. The tools 
depend on scene history and having contiguous scenes on the same 
layer can return incorrect results if applied to a single clip.

Remove Flicker  Flicker removal is very easy because only a single control is needed 
to get very good results.

The single control is Order. The order control is used to define 
how many segments the image is divided into for the purpose 
of brightness leveling. Unlike many “flicker removal” tools, Film 
Fix’s Flicker Remover works to even out brightness changes both 
between frames and within a single frame. Film Fix should be able 
to repair exposure degradation problems or brightness problems 
caused by warping of the original film frame.
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Flicker Remover default controls in the Effects Controls window

With a setting of 3, the image will be divided into three segments, 
and brightness will compared between them. Higher numbers 
mean more segments and slightly longer processing time.

We recommend Order values from 3 (the default) to 6. In most 
cases the default will work fine. If you find that you are not getting 
enough flicker removal with the default, try an Order value of 6. 
This should provide enough segments to fix most any problem.

Stabilize  The Stabilizer is a tool for removing jitter or other unwanted 
motion in a frame, such as camera jitter, gate jitter due to scan-
ning problems, or even smoothing out the shake in a hand-held 
shot. We will focus primarily on scanning problems typical to old 
scanned film. The motion is usually seen as jitter that causes the 
frame to jump, either up and down or side to side by a few pixels. 
It is visually distracting and not typically part of the original shot.

The Stabilizer tool works best if Flicker Remover is run first on the 
footage. Because of a quirk in After Effects, you will need to apply 
the Flicker Remover, precomp the Flicker remover source, then ap-
ply the Stabilizer to the new composition. 

 The Stabilizer plug-in can also treat camera shake if the shakiness 
was caused by instability in camera or other hand-held camera 
issues.
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The project window showing separate Flicker and Stabilize Comps.

Here are the steps for applying a manual stabilization.

1.  Apply the Flicker Remover plug-in (Effect > Film Fix > Flicker 
Remover–use the default values) to the footage layer in a com-
position.

2.  Pre-compose the footage (Layer > Pre-compose...)

Choose the Pre-compose... menu command from After Effects Layer 
menu

3. Apply the Stabilizer plug-in (Effect > Film Fix > Stabilizer) to 
the Precomp layer.

4. Set the Stabilizer Mode pop-up control to Manual.

5. Adjust the on-screen selection area to only cover a small back-
ground area in the frame.
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The Comp preview window showing the manual selection area

6. For small jitter as seen in the demo movie, you will want to set 
the Motion Range value to 2.0 %.

7. Because the stabilizer moves the frame compensate for the 
shake, black edges will appear at the edges.  You can also 
enlarge the video with Zoom Amount value of 102 to 104 to 
compensate for any black edges. In the case shown above, we 
chose a Zoom amount of 103.

Remove Dirt  Dirt Removal is usually the last step in any Film Fix cleanup pro-
cess. Typically, the footage should have any flicker removed and 
stabilized before applying Dirt Remover. This is not a hard and fast 
rule. Some footage may not need flicker or stabilization adjust-
ment, but in cases where these tools are needed, apply them before 
the Dirt Remover.
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 When using the Dirt Remover in combination with the other tools, 
we recommend that you render out the flicker and stabilized areas 
before applying Dirt Remover.

Here are the steps for removing dirt.

1. Drop the footage to be cleaned into a new Comp.

2. Add the Dirt Remover effect (Effect > Film Fix > Dirt Remov-
er) to the footage layer. 

The Dirt Remover plug-in with Advanced controls revealed

3. The Output mode should be set to Restored Frame.

4. Press the RAM preview on the Time Controls palette to start 
the process.

 The first two frames will show no dirt removal. This is intentional. 
The first two frames in any layer will not be cleaned because there is 
no motion history. If these frames need to be cleaned, then using the 
After Effects paint clone tool is the only option.

Rather than go through tweaking the Dirt Remover for one piece 
of footage, the following section shows images using the Dirt 
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Remover on one frame with different Image Mismatch Indicator, 
Motion Protection, and Threshold values so you can see what the 
output mask will look like with different values. The frames have 
are shown with the Output Mode control set to Overlay Detection 
Mask which draws a red mask on the frame in any area where the 
Dirt Remover identifies as “dirt”. 

The following pages show three examples of the same parameter 
with three different values. The results are not the final frame 
rendering but simply show where the Dirt Remover detector has 
identified a dirt target. Please refer to page 22 for more informa-
tion on the Dirt Remover and the specific control examples 
shown here.

 You should only use the Overlay Detection Mask mode for analysis. 
Remember to reset the mode to Restored Frame for final rendering.
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Dirt Remover  
Examples

Image Mismatch Indicator results for WWI_short_18fps.mov 
 

Image Mismatch Indicator is 10% (Default)

Image Mismatch Indicator is 3%–notice that much larger areas 
in the bottom left of the frame are identified as “dirt”.

Image Mismatch Indicator is 20%. A high value minimizes the detection 
area, notice how small the red areas are in the top of the frame.
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Dirt Remover  
Examples 
(continued)

Motion Protection results for WWI_short_18fps.mov 
 

Motion Protection Value is 20% (default)

Motion Protection Value is 5%–notice that this low value has meant that 
fewer pixels are targeted for cleanup.

Motion Protection Value is 50%–notice that the red areas are more pro-
nounced because more “pixels” are targeted with a high value.
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Dirt Remover  
Examples  
(continued)

Threshold results for WWI_short_18fps.mov 
 
 
 
 
 
 
 
 
 

 
Threshold is set to 25% (default). 
 

 

 

 

Threshold is set to 20%–notice that the lower value has created more 
“dirt” targets than with the default above. 
 

 

Threshold is set to 15%–notice that the low value has created a large 
number of “dirt” targets. This may lead to some image artifacts.
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Plug-in Controls

Dirt Remover We all know how to spot dirt in an image, but how do we teach the 
computer to distinguish dirt from ordinary details such as buttons 
on a shirt or birds in the distance? The Dirt Remover uses power-
ful motion analysis and a reference system based on the human 
visual system to try to mimic the way our brains identify dirt.

The Dirt Remover Effect controls in After Effects

The Dirt Remover includes both basic controls for setting the 
most oft-used controls and an advanced section to modify the 
controls related to motion detection.

Blotch Smoothness. This control is a measure of both overall size 
and smoothness of dirt in a frame. The detector trades off 
local image flatness (Blotch Smoothness) with the between-frame 
pixel difference (Image Mismatch Indicator) to detect dirt. So, a 
suspected dirt region has to have a large pixel mismatch as well 
as reasonably flat appearance for it to qualify as dirt. The default 
value is 2.0.
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Image Mismatch Indicator. This control sets the expected brightness 
difference between the dirt area and the surrounding pixels. It is a 
percentage and the default value is 10%. A high percentage re-
quires a dirty area to be very heavily contrasted against the back-
ground.

Motion Protection. This control lets you set a minimum threshold 
for the confidence of the motion estimation accuracy at each pixel. 
When the confidence exceeds this value, then the pixel is processed 
i.e. examined for dirt. Those pixels with confidences below this 
threshold are untouched and hence never examined for possible 
dirt. A motion protection value of 0, for instance, would allow all 
pixels to be examined for dirt, while one of 100% would forbid 
any pixel from being examined for dirt. The default value is 20%. 
See “Finding the Dirt” explanation on page 28 to understand why 
this control is useful. 

Output Mode. This control allows you to view the output of the Dirt 
Remover tool in different ways to help you analyze the results of 
the filter. There are four modes in the pop-up: Restored Frame, 
Binary Detection Mask and Overlay Detection Mask. Restored 
Frame is the default mode and it shows the processed frame with 
the dirt removed. You should set this option before doing a final 
render. Binary Detection Mask lets you see a black-and-white rep-
resentation of where the plug-in thinks there is dirt in the frame. 
Overlay Detection Mask returns an image with the dirt areas high-
lighted in red. This mode is very useful for seeing whether the dirt 
you can see in the frame is being properly detected by the plug-in.

Advanced  
Controls

 The Advanced controls let you guide the way the motion estimator 
works. The motion estimator starts by determining the pixel dif-
ference between the previous and next frames in blocks of pix-
els. Blocks in which motion has been detected are then matched 
between frames to locate similar blocks, and hence estimate the 
motion into the next and previous frames. The estimated mo-
tion is then smoothed across the blocks. That motion can then be 
assigned to pixels using an additional smoothing pass, or a simple 
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and fast assignment pass over the image. You should not really 
need to change the motion estimator settings, but a quick glance 
at the motion estimator output can help you decide if the motion 
estimator is behaving well or not.

Motion Detect Threshold. The motion analysis process in Film Fix 
tries to detect motion in blocks first before trying to estimate it. A 
simple way to think about motion detection is to consider that a 
block has a moving object in it if the inter-pixel differences be-
tween two blocks in consecutive frames are larger than some value. 
This control sets that value. The default value is 25.

Max Iterations. This sets the maximum number of times the plug-
in reviews the image to find dirt. Default is 10.

Protection Spread. The Protection Spread is the amount of spread-
ing of the confidence value from pixel-to-pixel; it is loosely con-
nected with the maximum amount of motion expected in the 
sequence. Increase this to protect larger areas from being touched. 

Block Size. This offers four values in a pop-up: 9, 17, 33, and 65. 
This is the block size in pixels that is used to match motion from 
frame to frame.

Motion Iterations. This controls how many times the estimator as-
sesses the confidence value for each pixel. More iterations means 
more accuracy, but much longer processing times.

Motion Smoothing. This pop-up offers four options for control-
ling the smoothing of the motion estimation. The options are 
No Smoothing, Block Smoothing, Pixel Smoothing, and Block 
and Pixel Smoothing. No Smoothing turns off the smoothing of 
motion information, while Block and Pixel Smoothing tries to 
smooth the estimation at both the block level and the pixel level.

Motion Recursion. This control lets you turn on or off the use of 
previously fixed frames during the dirt repair process. Once a pic-
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ture is fixed, if this control is On, the system reuses the last fixed 
image to help with the next one in the sequence; if it is Off the 
system uses the original image sequence all the time.

Quick Tips The following descriptions will help you understand what the 
values in the Dirt Remover do and when to change them.

Blotch Smoothness. Turn this up to detect only very flat bits of dirt, 
down to detect single pixel dirt.

Image Mismatch Indicator. Turn this up to detect less dirt, down to 
detect more. It should normally be at 10.

Motion Protection. Turn this up to leave more pixels alone, and 
down to change more of the picture. If you are having problems 
with fast-moving areas in the image, or areas with lots of motion 
blur, lowering this value should help.

Threshold. Turn this up to detect less dirt, and down to detect 
more. 20 is about right for many sequences. The typical range is 
10-30.

Motion Detect Threshold. Lowering the value tracks more motion 
and raising the value will track less motion in the frame.

Protection Spread. Larger values leave more pixels alone, and 
smaller values change more of the picture.

Block Size. Turn down this value to track the motion of very small 
parts of objects and up if the scene is very static.

Motion Iterations. Turn up to get more accurate motion in the 
frame but at the expense of longer processing times.

Motion Smoothing. Larger values will yield smoother motion fields.
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Motion Recursion. Turn this On to re-use previously corrected im-
ages and Off to recalculate the fixed area on each frame.

Problems &  
Solutions

 The Dirt Remover can sometimes be confused by strange motion 
in a frame or overlapping objects that can cause unwanted remov-
al of details. The following suggestions can help to fine tune the 
settings for this plug-in.

• If you find dirt being missed that you think should be de-
tected, try reducing the Threshold and the Image Mismatch 
Indicator.

• If you find that edges of the dirt seem to be missed, increase 
Blotch Smoothness, and decrease the value of Image Mismatch 
Indicator or increase Motion Iterations if all else fails. Note 
that 20 iterations should be sufficient in most cases, and only 
in extreme situations would numbers above 30 be justified.

• If your dirt is typically a few large pieces (>20 pixels on a side 
in a standard-definition-size image) and flat pieces of degra-
dation, use large values of Blotch Smoothness such as 5 to 10.

• If your dirt is tiny, reduce Blotch Smoothness to 1.0. Remem-
ber that Blotch Smoothness and Image Mismatch Indicator 
trade off flatness with image differences. Large flat pieces of 
dirt of low contrast are therefore best detected with high val-
ues of Blotch Smoothness and low values of Image Mismatch 
Indicator.

• If your images are in generally good condition and do not 
contain much noise, then you could reduce the Motion Detect 
Threshold to 1.

• Another way to notice that the Motion Detection Threshold 
should be reduced is if you find that the Overlay Motion Vec-
tor mode shows no vectors where you can in fact see motion.
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• If you have many small details you’d like to track, but the mo-
tion estimator is not tracking them, then reduce the block size 
to 9 pixels.

• If you find that the motion field across a contiguous object is 
not smooth, then change the Motion Smoothing pop-up to 
Pixel Smoothing or Block and Pixel Smoothing.

• If you have particularly noisy images, turn up the Motion 
Detect Threshold value to 5 or more.

• If your motion field looks right, but the Overlay Detection 
Mask is showing incorrect areas of dirt, try increasing the Mo-
tion Iteration value to 40. Typically you don’t need to change 
the default.

Background What is Dirt? Most people would say that dirt is a small flat patch 
of pixels that are darker or brighter than the surrounding image 
pixels. Sadly, this is also a good description of many small image 
details in clean images–for example, the glint of an earring, high-
lights in hair or buttons on a shirt. 

Finding the Dirt. Thankfully, when many images are observed in a 
sequence, a pattern emerges that helps distinguish dirt from image 
details. The most powerful clue is that dirt does not occur in the 
same place in consecutive image frames. But because objects in  
interesting scenes can move around, the detector has to com-
pensate for motion before working its magic. Film Fix’s motion 
estimation process tracks the location of each pixel in the image 
across successive frames. Most of the advanced controls deal with 
the settings for Film Fix’s built-in motion estimator. Image de-
tails, such as buttons tend to be found in almost the same place 
in successive frames, while a piece of dirt in one frame cannot be 
found in any other frame. This means that for a pixel of dirt, there 
is a large difference between that pixel and the pixel in the last and 
next frames (allowing for motion). The detector that is used in 
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Film Fix also analyzes flatness and size information to detect these 
pixel areas as dirt.

Hiding the Dirt. Once the dirt is detected, the easiest method to hide 
the dirt is to cut and paste pixels from either future or past frames. 
Because things move around, the reconstruction process has to 
know where in the next or past frame to take the pixels from. One 
would normally do this with motion estimation, but the pixels at 
the dirt site throw off the motion estimation. So the motion infor-
mation is probably going to be wrong in this region. Instead, the 
Film Fix image reconstruction process fixes the motion in the dirt 
region before going on to cut and paste. Motion reconstruction 
is a tricky business, and Film Fix uses both motion history and 
motion from nearby regions in the current image to recreate the 
motion information. Finally, the image regions are combined and 
filtered. The result is that the dirt is hidden in a visually natural 
way.

Notes on  
Motion  
Estimation

 No one has developed a motion estimator that can cope with every 
single possible object motion that could be observed. Objects like 
clothing in particular tend to move around in unpredictable ways. 
Therefore, to avoid problems when the motion estimator comes 
across these unpredictable areas, Film Fix tries to monitor its own 
performance, and gives a confidence at each pixel that the motion 
estimator has done its job. This is scaled between 0 and 100%, and 
is spread over a large pixel region to protect parts of the image 
where motion may be badly behaved. If you observe picture areas 
that are unpredictable or random, but are not dirt being damaged 
e.g. at the edge of a bit of clothing, then try increasing the Protec-
tive Spread or decreasing the Motion Protection value to produce 
better results. 
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Flicker  
Remover

Many archival images suffer from brightness variations that are vi-
sually distracting. Brightness variations can happen from frame to 
frame or these variations can actually appear across a single frame. 
The Flicker Remover tool tries to compensate for both types of 
brightness variations.

The Flicker Remover controls are very simple.

Fortunately, you don’t need to worry about choosing modes or 
wrestling with lots of parameters. The Flicker Remover tool only 
has a single control.

Order. This number corresponds to the number of blocks or areas 
of the image that are analyzed for brightness variation. Turn this 
up to divide the image into more blocks to compensate for varia-
tions within the frame.

Tip The Order control only needs to be increased if you have large 
areas of non-uniform brightness in an image. These may be 
caused by warping of the original film frame or storage problems 
that have caused fading in parts of the frame. Try values of 5 or 6 
in these cases. 
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Stabilizer Often scanned images have alignment problems and tend to jitter 
up and down or side to side. Films can also have original cam-
era problems that have nothing to do with the scanning process 
but that require smoother motion. The Stabilizer plug-in tries to 
smooth out or lock down the motion in a frame with frame-to-
frame analysis. The stabilizer will attempt to reposition each frame 
to compensate for the motion.

The Stabilizer controls in After Effects

 The Stabilizer has two modes of operation and controls to adjust 
the sensitivity and scaling of the output frame. The following sec-
tion describes each of the controls.

Motion Detect Mode. This pop-up lets you choose between Auto-
matic and Manual modes. For footage that is panning and /or 
zooming, use the Automatic mode. If you have a fixed shot and 
want to lock down the motion, you may want to choose the 
Manual mode and then select a background area with little or no 
motion.

Manual Detect Region. This area has two corner controls, Corner 1 
and Corner 2. These two controls are the upper left (Corner 1) 
and lower right (Corner 2) bounds of the region you want to use 
when determining the motion in the frame. You can set these 
values numerically or visually by clicking and dragging the point 
indicator in the Comp preview window. 
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To manually select the correct region, try to find out which part of 
the image is most affected by the motion you find annoying.  
Typically, this will be in a region of background that you feel 
should be steady, but isn’t. Target this background area to use as 
your manually selected region. 

Motion Range. The motion range is the amount of variation in the 
motion in the frame. Large values correspond to quick zooms or 
pans in the frame, while small values would correspond to jitter in 
the frame. Try values of less than 2 percent if you are compensat-
ing for jitter in the scan of the image.

Zoom Amount. This controls lets you zoom up the image to crop 
any black areas from the edge of the frame that arise from the 
stabilization process. Typically you only need to increase this value 
a couple of percent to remove the black borders around the frame 
edge.

Stabilize Type. This pop-up offers two modes: smooth and locked. 
The smooth mode is appropriate for removing jitter in a panning 
or zooming shot. The locked mode is best used when you know 
that the original camera was fixed and you want to eliminate the 
motion in the frame.

Offset X/Y. This control lets you offset the frame from the center if 
the image drifts out of frame during the stabilization process. It is 
best to set a single hold keyframe at the beginning of the layer and 
then insert a new keyframe at the first frame where the drift starts 
so you can re-center the image at this point in time.

Rotation. This switch lets you compensate for rotation jitter or 
motion in the frame. This is best used in Automatic mode on pans 
when you have relatively little motion in the frame. 

 The Rotation detection is ignored if the Motion Detect Mode is set 
to Manual. 
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Tear Remover  The Tear Remover is a filter designed to realign spliced areas in 
a film frame. In almost all cases, the torn or spliced region only 
appears on a single frame (though different tears can appear on 
successive frames). Often a film is ripped, torn or spliced in a 
non-uniform way and the seam created by the tear needs to be 
realigned to create a repaired seam that looks natural. 

The Tear Remover effect controls in After Effects

In all cases, the Tear Remover will be used in combination with 
the Stabilizer and Dirt Remover tools. The Stabilizer will help to 
realign the frames around the torn region and the Dirt Remover 
will be used to actually repair the pixels in the seam area.

 Before applying the Tear Remover filter, a mask or path must be 
created that surrounds the torn area. You will use the Tear Path 
control to designate the path that surrounds the torn area. Here 
are the controls available in the Tear Remover.

Tear Path. A pop-up that you use to designate the mask shape sur-
rounding the torn region you want to fix.

Use Path. This is a keyframable control for setting the frame where 
the path will be processed. You will need to set three keyframes for 
this control, the first with the “Use” button unchecked one frame 
prior to the tear, the second should set the “Use” button to checked 
on the tear frame, and the final keyframe should set the “Use”  
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state unchecked. The keyframe setup is illustrated in the screen 
shot below.

Keyframes set for the “Use” parameter in the Timeline window

Invert Mask. You may want to invert the mask region used in some 
cases. This checkbox provides a quick method for inverting the 
region that will be processed by the Tear Remover.

Advanced  
Options

You can use the advanced options to fine tune the alignment pro-
cess. The controls and values are similar to those used in the Dirt 
Remover plug-in.

Motion Detect Threshold. This control determines the cutoff for 
inter-pixel differences between blocks in a frame. See the Dirt 
Remover section on page 24 for more information.

Block Size. This offers four values in a pop-up: 9, 17, 33, and 65. 
This is area size in pixels that is used to match motion from frame 
to frame.

Motion Iterations. This controls how many times the estimator as-
sess the confidence value for each pixel. More iterations assure the 
more accuracy from the motion estimator, but at the expense of 
longer processing time.
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Motion Smoothing. This pop-up offers four options for control-
ling the smoothing of the motion estimation. The options are 
No Smoothing, Block Smoothing, Pixel Smoothing and Block 
and Pixel Smoothing. No Smoothing turns off the smoothing of 
motion information, while Block and Pixel Smoothing tries to 
smooth the estimation at both the block level and the pixel level.

Film Fix  
Automation  
Palette

 A script-based palette has been built for use with the Film Fix 
tools that lets you quickly apply the Film Fix plug-ins with com-
mon presets as well as combinations of the plug-ins. You can 
access this palette from the Run Script command on the File menu 
(File > Run Script > Film Fix Automation.jsx).

The command will bring up a palette that has preset applications 
of the plug-ins. Most of the buttons apply the plug-ins with one 
click. This makes the set-up of projects much easier because you 
don’t have to rely on the menus or commands in After Effects to 
apply the plug-ins. Users who are relatively new to After Effects 
will find this helpful for speeding up the cleaning process. For 
those that are After Effects experts, the scripts can be edited to suit 
your needs. The JavaScript files that correspond to each button 
can be found in ~\Program Files\Adobe\After Effects 6.5\Support 
Files\Scripts\(filmfix).

The Film Fix script palette showing one-click apply buttons

Below is the description for each of the buttons in the palette. 
There are four categories of buttons corresponding to the different 
plug-ins. 
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Flicker Basic. Applies Flicker to a selected layer in Comp 
Operation: Apply Flicker Remover, Order =3

Flicker Complex. Applies Flicker to a selected layer in Comp 
Operation: Apply Flicker Remover, Order=6

Stabilize Locked. Applies Stabilize to a selected layer in Comp 
Operation: Apply Stabilizer, Motion Detect Mode=Automatic, 
Motion Range=3%, Stabilize Type=Locked

Stabilize Smooth. Applies Stabilize to aselected Layer in Comp  
Operation: Apply Stabilizer, Motion Detect Mode=Automatic, 
Motion Range=6%, Scale=100, Stabilize Type=Smooth

Stabilize + Rotate. Applies Stabilize to a selected layer in Comp  
Operation: Apply Stabilizer, Motion Detect Mode=Automatic, 
Motion Range 6%, Stabilize Type=Smooth,  
Rotation=Use Rotation checked

Dirt Basic. Applies Dirt Remover to a selected layer in Comp  
Operation: Apply Dirt Remover, default settings

Dirt Small. Applies Dirt Remover to a selected layer in Comp  
Operation: Apply Dirt Remover, Blotch Smoothness=1.0, Image 
Mismatch Indicator=6%, Motion Protection=30%, Threshold=20, 
Block Size=9, Motion iterations 25, Motion Smoothing=Pixel 
Smoothing

Dirt Strong. Applies Dirt Remover to a selected layer in Comp  
Operation: Apply Dirt Remover, Blotch Smoothness=1.0, Image 
Mismatch Indicator=4%, Motion Protection=55%, Threshold=16, 
Block Size=9, Motion iterations=35, Motion Smoothing=Pixel 
and Block smoothing.
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